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Introduction 

Congratulations on choosing the Noxturnal® application software. The Noxturnal software is a modern sleep 

diagnostics software platform designed for ease of use and operation efficiency. The Noxturnal software is an 

essential part of the Nox Sleep Assessment Systems. Its main function is to work with physiological signals 

recorded/received using devices from Nox Medical (see Supported Devices chapter) and their linked devices 

and accessories. It takes the user through the workflow of configuring recordings, downloading data, analyzing 

and reporting.  

Intended Use 

The Nox Sleep System is used as an aid in the diagnosis of different sleep disorders and for the assessment of 
sleep. 

The Nox Sleep System is used to measure, record, display, organize, analyze, summarize, and retrieve 
physiological parameters during sleep and wake in patients greater than 2 years of age.  

The Nox Sleep System allows the user to decide on the complexity of the study by varying the number and 
types of physiological signals measured. 

The Nox Sleep System allows for generation of user/pre-defined reports based on subject´s data. 

The user of the Nox Sleep System are medical professionals who have received training in the areas of 
hospital/clinical procedures, physiological monitoring of human subjects, or sleep disorder investigation. 

The intended environments are hospitals, institutions, sleep centers, sleep clinics, or other test environments, 
including patient’s home. 

Contraindications 

The Nox Sleep System does not provide any alarms and is not intended to be used for continuous monitoring 
where failure to operate can cause injuries or death of the patient. 

Scope 

This manual covers the use of the Noxturnal software. The use of the Nox devices and their accessories that 

are needed for the recording of physiological signals are covered in: 

● Nox A1 Manual 

● Nox A1s Manual 

● Nox C1 Manual 

● Nox T3 Manual 

● Nox T3s Manual 

 

This manual also includes a short introduction about the Noxturnal App and its features.  

Warnings and Cautions for Use 

 Warning: The Nox Sleep Assessment Systems are NOT CERTIFIED TO BE USED FOR 

CONTINUOUS MONITORING where failure to operate can cause injuries or death of the 

patient. 
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 Warning: The Nox Sleep Assessment Systems are intended as an aid in diagnosis of sleep 

disorders. The systems must be used in conjunction with other methods of assessing 

clinical signs and symptoms. 

 Note: Automatic analysis may be less accurate than analysis conducted by trained 

physician. The result of the automatic analysis/scoring must always be manually verified 

by the trained physician prior to diagnosis. 

 Warning: Derived signals calculated by Noxturnal, especially heart rate and respiratory 

rate from the underlying electrocardiogram (ECG) and respiratory effort signals, are not 

validated for patients with diaphragm pacing/phrenic nerve stimulators. 

 Warning: The Nox A1, A1s, T3 and T3s Recorders shall under no circumstances be 

connected to the USB port on the PC while applied to the patient. This could result in 

electroshock to the patient and serious harm. 

 

 Please read this manual carefully before use, especially sections marked with an 

exclamation mark. 
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Noxturnal Description 

The Noxturnal software interacts with Nox Recording Devices and Nox Access Points. It allows the 

configuration of the devices as well as: displaying, navigating, organizing, analyzing, reporting, archiving and 

retrieving physiological signals recorded/received by use of the Nox devices. This section describes the main 

features of the application and installation instructions. 

Noxturnal App Description 

The Noxturnal App is an Android application that is used as a mobile interface to Nox A1 Recorders and Nox C1 
Access Points. The app allows the user to perform certain tasks already known in the Noxturnal software with 
more flexibility and proximity to the patient.  
The App features include: 

 

• Configure ambulatory recordings 

• Connect to online rooms that have been 
configured in Noxturnal 

• Review signal quality 

• Perform impedance check 

• Perform bio calibration 

• Start and stop recordings 

• View status of online recordings (Recording, 
Standby, Not Prepared)  

 

To download the app, scan the QR code above or search for “Noxturnal” in the Google Play Store. The app runs 

on mobile devices running Android 8.0 or higher. 

INTERFACES 

The Noxturnal App uses wireless Bluetooth technology (Classic and/or BLE) for establishing communications 

with the following devices: 

• Nox A1 Recorder 

• Nox A1s Recorder 

• Nox C1 Access Point 

• Nox T3 Recorder 

• Nox T3s Recorder 

The devices support pin code configuration for authentication purposes. When enabled, the Noxturnal App will 

prompt the user to enter the pin code. Communication is established only if a correct pin code is entered. 

Supported Devices 

Noxturnal supports the following Nox devices and their linked devices and accessories: 

• Nox A1 Recorder 

• Nox A1s Recorder 

• Nox C1 Access Point 

• Nox T3 Recorder 
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• Nox T3s Recorder 

In this manual, a Nox Recorder is used as a collective name for Nox A1, Nox A1s, Nox T3 and Nox T3s recorder. 

Throughout this manual, a Nox T3 recorder and Nox T3s recorder are collectively referred to as Nox T3 

recorders. Likewise, a Nox A1 recorder and Nox A1s recorder are collectively referred to as Nox A1 recorders. 

Installing Noxturnal  

Before installing the Noxturnal software, review the system requirements for running the software application. 

Noxturnal System Requirements 

 

 Note: The computer used must comply with the international standard IEC 

60950-1 for the safety of information technology equipment. 

 Note: It is recommended that a virus protection be installed on the computer 

running Noxturnal. 

The following table shows the minimum hardware requirements needed to install and operate the software 

effectively. 

Minimum System Requirements 

Hardware Type Minimum Requirements 

Operating System Windows 10 

Processor x64 based Intel or AMD 

Processor Clock Speed 1.7 GHz or faster 

Memory 2 GB or more 

Free Hard Drive Space 4 GB or more 

Graphics Resolution 1024x768 or higher 

For online system setup, the same minimum system requirements apply as listed above. It is highly 

recommended to use a separate computer for each online system. However, for expert users it is possible to 

run more than one system on a single computer. 

It is recommended to implement good IT practices such as: 

• Control access to the PC running the system 

• Enforce password policies 

• Keep the PC operating system up to date 

• Follow Microsoft Windows end of support dates 

• Install an antivirus protection software 

• Limit the usage of the PC for clinical use only 

• Backup recording data location – Noxturnal does not handle backups of data 

Note: connections to external systems such as Nox Cloud, GDT, or HL7, Noxturnal acts as a client relying on the 

existing system setup for security. 
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Installation Instructions 

• Make sure to be logged onto the system with administrator privileges. 

•      Browse for a file on the installation CD or the installation web site called Setup.exe and run it. 

• A wizard opens that guides the user through the installation. Follow the instructions to install the 

application. If upgrading from Noxturnal 5.x, an upgrade process runs in the background. Upgrading 

the user application settings. A copy of the settings prior to the upgrade is stored in “[My 

Documents]\NoxturnalUpgrade”.    

 

 

 

 For information about the latest software version and upgrade information, 

please contact your distributor. For distributor information go to: 

www.noxmedical.com. 

 For operational support, in case of user errors, cybersecurity events or other 

type of events, please contact support@noxmedical.com 
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Standard Operation 

To run the Noxturnal application, double-click on the desktop icon or click on the application icon in the 

Windows start menu. To close the application either click on the X in the top right corner, or in the File menu 

choose Exit. 

When Noxturnal starts up the workspace environment is displayed. If you have a device connected, you will 

see that in the picture, otherwise no device will be displayed. For the purposes of this document we have a 

Nox T3 Recorder connected as can be seen in the picture. 

 

The Recording page is where the user works with Nox devices and the data recorded/received by use of those 

devices. This page guides the user through the most common tasks which are possible to perform in the 

application. These are: 

• Library: In the top left corner, you will see this option. This option opens the recording library. The 

library stores a list of all recordings that have been recorded, downloaded or manually added to the 

recording library. For more information, refer to the section The Recording Library. 

• Configure Device: To start a new ambulatory recording, select this option. A configuration wizard will 

guide the user through the configuration process. For more information, refer to the section Starting 

a New Ambulatory Recording. 

• Download Recording: If a recording device is connected and it contains a recording, the user may 

download and review the recording. For more information, refer to the section Downloading an 

Ambulatory Recording from a Nox Recording Device.  

To configure an online recording an online room needs to be pre-configured and it will appear on the 

Recording page and be selectable. For instruction on how to configure an online recording refer to the section 

Setup of the Nox Sleep System for Online Recordings.  
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Connecting a Nox Recording Device to Noxturnal  

 

 Note: Please note that although it is recommended to eject the recording device 

before unplugging it from the computer the device can be disconnected without 

ejecting. 

Noxturnal is used to configure and download recorded data from Nox recording devices. To work with a 

recording device, start by connecting it with a USB cable to the computer. Noxturnal automatically detects the 

device and displays information about the device. Detection can take 2-4 seconds. 

When Noxturnal detects the connected device the following information about the device is displayed: 

recording status, firmware version and device name.  

The tasks performed on the recording device depend on the device status which can be the following: 

• Empty – The device has not been configured and does not contain any recordings. Click Configure 

Device to configure the device for a new recording. Please note that configuring the device will 

remove any existing recordings from the device. 

• Ready to Record – The device has been configured but does not contain any recordings. At this point 

the user can disconnect the device and initiate the recording process. 

• Ready to Download – The device contains a recording that has not been downloaded to the 

computer. Click on the Download Recording button to download the recording to the computer. 

• Download Complete – The device contains a recording that has already been downloaded and has 

been added to the recording library. At this point the user can either click on Configure Device to 

configure the device for another recording or click on Download Recording to download the 

recording again. 

When you are done working with the device click on the Eject link and unplug the device from the computer. 

Upgrading the Recording Device Firmware 

 

 Note: After clicking the upgrade firmware notification, you must disconnect the 

recording device from the computer and reconnect it again for a device 

firmware upgrade to take place. 

 Note: It is always recommended to perform the device firmware upgrade to 

make sure the Nox recorder is running on the latest firmware version. New 

firmware versions can include important updates for the operation of the 

recorder.  

If a new version of the device firmware is available for the connected device, Noxturnal will notify the user. 

This behavior is device independent and you will see the type of device on this page, depending on which 

device you have connected. In this picture, we have a Nox T3 Recorder connected. 
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Choose either to ignore this message and continue working, or to upgrade the device firmware, which is 

always recommended. To upgrade click on the New firmware available and then follow the instructions 

presented. 

Starting a New Ambulatory Recording  

To prepare a recording device for a new recording, start the Noxturnal application and connect the device to 

the computer using a USB cable. Noxturnal automatically detects the device and shows information about it on 

the Recording page. Click on the Configure Device button on the Recording page and a wizard opens which 

guides the user through the configuration process of the device. 

The Configuration Wizard is device dependent. This means that the configuration wizard will vary depending 

on the type of Nox recording device being configured. However, the key steps are always the same: 

1. Configuration of the device. Where you select the Recording Type to use (auxiliary devices that may 

be connected and channels to be recorded). 

2. Schedule Recording where you can select the time and date for a recording to start or to have a 

patient start the recording themselves. 

3. Patient Information where you add the necessary patient information to the recording. 

This manual shows the configuration wizard for the Nox T3 Recorder. The first step is to define which 

Recording Type to use for the recording. The Recording Types have descriptive names to exhibit the recordings 

they are used for. 

See the Recording Types and Device Profiles sections for more information on creating and editing recording 

types and device profiles. 
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If your Recording Type is set up to record data from an auxiliary Bluetooth device, e.g. pulse oximeter you will 

see that in the Configuration Wizard. To be able to use auxiliary Bluetooth device it needs to be paired to the 

Nox recording device. Enter the appropriate Bluetooth device Pin/BDA (Bluetooth Device Address) number in 

the relevant field in the Configuration Wizard.  

For some devices, it is required to pair the device with the oximeter used. After entering the BDA address of 

the oximeter, click the Pair with Oximeter button and wait for the response. Note that the oximeter needs to 

be turned on by pressing the button of the oximeter when performing this step. Follow the instructions that 

appear on the screen.  

Click Next to move on to step two where you schedule the recording time. 
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• If the By Connecting Nox RIP Belts (Start on Belt) option is checked, the recording will start when the 

user connects the Nox RIP belts to the Nox recording device. The duration for this option is 

Unspecified as the recording will stop by disconnecting the belt from the recorder. The feature is only 

available for Nox T3s and A1s devices with firmware 3.1.0 or newer. 

• If the By Pressing button (Manual) option is checked, the user is responsible for starting/stopping the 

recording from the Nox recording device. This is done by pressing and holding the Push button on the 

device until the device display indicates that the recording has started. 

• Check the At Scheduled Date: option to schedule a specific recording time. The device will turn itself 

on and automatically start recording at the specified time. If the user chooses to record for more than 

one night, each recording will start at the same time each night. 

• To stop recording after a specific duration, specify the Duration to be either: 7 Hours, 8 Hours, 10 

Hours or enter a customized duration. If Unspecified is chosen, then the user is responsible for 

stopping the recording. This is done by pressing and holding the Push button on the device until the 

device display indicates that the recording has stopped. 

Click Next to continue to the third step, the patient information dialog. In this dialog, it is possible to enter 

detailed information about the patient. The only required field is the patient name or the patient ID.  
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After having entered the patient information click Finish to write the configuration to the device.  

If there is a recording on the device, the user will be asked if he wants to erase the recording from the device. 
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Finally, a confirmation page appears confirming the device has been configured. For Nox T3 Recorders the 

hookup instructions can be printed by clicking the Print Hookup Instructions button. A PDF document 

containing the hookup diagram is launched and can be printed. If no hookup instructions are available, this 

option is not displayed. 

   

Recording Types 

Noxturnal offers a range of Recording Types available for configuration of both ambulatory and online 

recordings. The Recording Types encompass the device combination used for different types of sleep studies 

and the device settings. The Recording Types also define the automation for the different recordings, the 

relevant Workspace Layout, Analysis and Report that are used for the recording. In Noxturnal you can easily 

create your own Recording Types to control devices and settings used for recordings. Follow these steps in 

order to create your own Recording Type.  

1. Select the Nox recording device you are creating the Recording Type for and if it is intended for 

ambulatory or online recordings. 

2. Set up the Recording Type to include Workspace Layout, Analysis, Report and devices and device 

profiles to be used, as applicable. 

The Recording Type Wizard is device dependent. This means that the wizard will vary depending on the type of 

Nox recording device being configured. However, the key steps are always the same: 
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From the Noxturnal toolbar navigate to Devices > Recording Types…  

 

The Recording Types Wizard will open up. 

  

  

Here you can create a New Recording Type, a New Based On one of the available Recording Types and Edit or 

Remove custom Recording Types. For this example we will create a new Recording Type for the Nox T3 

Recorder.  

Select the Nox T3 (ambulatory) Recording Type from the dropdown list as shown below. 
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The next step is to set up the Recording Type as applicable. In the following wizard you can set up your 

Recording Type.  
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Type in the Recording Type Name and Description of the recording type. Choose the applicable Workspace 

Layout, Analysis and Report. You also have the availability to add auxilliary devices. Choose for example the 

Nonin 3150 (under Device Types) and click Add>>. 

 

Note that it is also possible to choose the applicable Device Profile for this Recording Type directly in the 

Recording Type wizard, see below.  
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You can also create custom Device Profiles, please follow the instructions in the Device Profiles section for 

further instructions. Once you have created a new Device Profile it will appear in the dropdown list in the 

Recording Type wizard. 

When you have set up your Recording Type click OK and your custom Recording Type will be available for 

configuration.  

Device Profiles 

 
 Note: The Device Profiles wizards vary between Nox recording devices. 

The Device Profiles are created for all standard recordings that you might perform with Nox devices. They 

allow for simple setup during the device configuration process. 

From Noxturnal toolbar navigate to Devices > Device Profiles… 
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In the Device Profiles wizard, you can see list of the available Device Profiles for the Nox recording devices and 

the Nox access point. 

 

To create a custom device profile, select New or New Based On. You will then need to select for which 

recording device the template is for or from which of the current device profiles you wish to base your new 

template on. For this example, we will create a new device profile for the Nox T3 Recorder. 
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In the Profile Properties Wizard, you can setup the Device Profile. Type in the name (and description if you 

wish).  

  

Click Next to proceed to the next step. 

In the dialog below you can setup the channel configuration for the device. The Configure Device dialog is 

device dependent. This means that the wizard will vary depending on the type of Nox device being used. When 

you have setup the channel configuration, click Next. 
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The final step for configuring a Nox recording device is to define the battery type used. Select the applicable 

battery type and click Finish. 
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The Device Profile you created will be available from the list of Device Profiles and available for configuration.  

Downloading an Ambulatory Recording from a Nox Recording Device  

 

 Note: If a download partially fails for any reason, it can lead to inconclusive 

recording results. The user will be warned when this happens and needs to 

decide whether the recorded data is complete or not. It is possible to download 

the data from the device again. 

 Note: The downloaded recording is not deleted from the device until the device 

is configured for another recording. 

To download recorded data from a Nox recording device to the computer, ensure that Noxturnal is running 

and then connect a device to a USB port on the computer. 

Noxturnal automatically detects the device and shows information about it on the Recording Page. Detection 

can take 2-4 seconds. 

Click on the Download Recording button on the Recording Page and Noxturnal will start downloading the 

recording from the device to the computer. A download progress dialog will appear that displays the steps 

involved while downloading. The data is first downloaded then the default analysis protocol is run and, if the 

device was configured to record audio, the audio download starts.  

  

After the download is completed the user is notified and can start working with the whole recording. 

Recordings are always downloaded to the default data storage location. It is possible to change the default 

data storage location on the automation tab in the tools options dialog (Tools → Settings… → General). 

Downloaded recordings are automatically added to the recording library and can be reviewed any time by 

going to the recording library and opening it. For more information, refer to section The Recording Library.  
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Setup of the Nox Sleep System for Online Recordings  

Online System Network Overview 

To ensure steady operation of the online functionality for the Nox Sleep System please follow the 

recommended system setup below.  

• It is recommended to use a separate computer for each online system setup. However, it is possible 

to run more than one online system on a single computer; refer to Minimum System Requirements 

section for details.  

• Use a separate local area network (LAN) for each Nox C1 Access Point and a computer running the 

Noxturnal software. 

• Use a separate Nox C1 Access Point for each Nox A1 Recorders to be used. 

The table below describes the setup of the control room where the computer with Noxturnal installed is 

located.  

Control Room 

Item Connection 

PC 
Connected to the same network as the Nox C1 

Access Point with a network cable 

Noxturnal Installed on PC 

The table below describes the setup of the patient room where the patient is sleeping during a sleep study. 

Patient Room 

Item Name Description Function Setup/Connection 

Nox C1 Access 
Point 

Bluetooth access point 
with analog and serial 
inputs and built in light 
sensor and differential 
pressure sensor 

 Data transfer received 
from Nox A1 over 
Bluetooth connection 
and forwarded to 
Noxturnal via Ethernet 

 Commands received 
from Noxturnal via 
Ethernet and 
forwarded to Nox A1 
using Bluetooth 
connection 

 Data transfer received 
from auxiliary devices 
connected to analog 
and/or serial inputs 
and forwarded to 
Noxturnal via Ethernet 

Located in the patient 
room. Connected to 
the same LAN as the 
PC running the 
Noxturnal software 

Nox A1 Recorders 
and applicable 
sensors 

Recording device that 
may be configured for 
different types of sleep 
studies 

Records physiological 
signals from built-in and 
attached sensors 

Attached to the 
patient in the patient 
room 



Noxturnal Manual 

   

~ 28 ~ 

Medical auxiliary 
devices 

Any medical device 
that fits the input 
channel specifications 
of the Nox C1 Access 
Point. Medical devices 
supported by the 
system to be  
connected to Nox A1 
Recorders via 
Bluetooth link 

Depends on the auxiliary 
device being used 

The applicable 
connection cable 
connected to the 
analog input/serial 
input on the Nox C1 
access point. Via 
Bluetooth link to the 
Nox A1 Recorders 

Noxturnal App Android App  

Can be used to connect to 
Online Rooms, review 
signal traces and perform 
bio calibration and 
impedance check. Can also 
be used to start and stop 
recordings 

Set the App to Online 
Mode and connect to 
the applicable online 
room 

Figure below shows the overview of the online setup for the Nox Sleep System.  

  

The Nox C1 Access Point is operated by the Noxturnal software.  

For further instructions on the Nox C1 Access Point and the Nox A1 Recorders refer to the Nox C1 Manual and 

the Nox A1/A1s Manual.  

Refer to the “Compatible Devices” section regarding the types of Ethernet supported devices and switches that 

have been validated with the Nox Sleep System. 
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Online System Configuration 

This chapter describes how to setup the Nox Sleep System for online configuration. First make sure that you 

have setup all the devices and accessories needed, such as the Nox C1 Access Point, Ethernet cables and 

switch. Detailed information on how to setup your network, including the Nox C1 Access Point, is found in the 

Nox C1 Manual.  

To set up the Nox Sleep System for online configuration you must perform the following steps in Noxturnal, as 

applicable: 

1. Set up Online Rooms 

2. Configure new Sensors 

3. Set up Device Profiles 

4. Set up Recording Types 

These steps are outlined below. Following these steps will allow you to start your online recording and then 

start working with the signals in Noxturnal. 

Online Room 

Setting up an Online Room is part of setting up Noxturnal for online recordings. The Online Room encompasses 

collection of devices which you normally keep together in a room. These may, for example, be all the devices 

that you keep in a particular hospital room dedicated for sleep studies.  

To add a new room, select Devices > Online Rooms… from the Noxturnal toolbar. This will bring up the Rooms 

dialog. 
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From here you can add a new room or edit an existing one. To add a new room click Add Room and in the 

dialog below you can give the new room a name, by clicking the pencil icon and add devices to your room by 

clicking Add Devices. 

 

 

In the Add Devices Wizard you can add devices to your room. To add a device, select the applicable device 

from the Device Types list and click Add >> or double-click the device from the list. You can scan for connected 

IP devices on your network by clicking Scan for IP Devices. 
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When you add Nox A1 Recorders you will need to select the applicable Nox C1 Access Point being used in the 

room and click Scan for your Nox A1 Recorder or manually type in the A1 serial number. Remember to have 

your A1 Recorder turned on for this step. Select your recorder from the list and click Next.  
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When you have added a selection of devices to collection of available devices you can select the devices to add 

to your Online Room.  

 

To select devices to add to your room click the device and a blue bold frame will appear around each selected 

device. When you have selected the devices to add to the room, click Add to Room and your room with this 

selection of devices will be added. 

 

You have now completed the configuration of the online room. You can in the same way as described here 

above add additional rooms.  
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Configuration of New Sensors 

If you want to create new sensor configurations, e.g. to use with the Nox C1 Access Point, you can do that by 

navigating to Devices > Sensors… from the Noxturnal Toolbar. 

   

From the Manage Sensors Wizard you can create a new sensor and edit/delete existing sensors. To create a 

new patient or auxiliary device sensor click New. Patient sensors are sensors connected to Nox A1, T3 or T3s 

Recorders and the patient. Auxiliary device sensors are connected to Nox C1 Access Point and an auxiliary 

device.  

 

You can select whether a new patient sensor or an auxiliary device sensor is to be created. Fill in the applicable 

fields and click OK to save the sensor configuration. 

Device Profiles for Online Devices 

For the Nox devices used for online recordings you can set up Device Profiles. The Device Profiles encompass 

the device’s channel configuration. Noxturnal offers a range of default Device Profiles and you can also easily 
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setup new Device Profiles. For instructions on how to customize Device Profiles refer to the Device Profiles 

section. 

Recording Types for Online Devices 

The final step is to set up Recording Types. This is a list of the types of recordings that you will record online in 

your clinic. Each Recording Type brings together a collection of available online device types which would be 

grouped together. Examples are: Standard PSG with Nox C1, would bring together a Nox C1 Access Point, Nox 

A1 Recorder, Nonin 3150 Oximeter and a Video Camera. For instructions on how to setup new Recording 

Types refer to the Recording Types section. 

Starting an Online Recording 

When you have completed the steps above to setup your online configuration an online recording can be 

started. From the Recording page you can start an online recording within the room you have set up. To start 

the recording either double-click the room icon or click Configure Recording. 

 

This will bring up the Start Online Recording wizard. This wizard will allow you to: 

• Select the Recording Type which is about to be performed from the dropdown list. 

• The selection of Devices is dependent on the Recording Type selected. All devices available in the 

online room are listed, however the devices not included in the recording type are greyed out. 

You can include the disabled devices for the recording by checking the appropriate boxes from 

the list of devices. 

• Select Device Profile for some devices, such as the Nox A1 and the Nox C1. 
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When you have selected your Recording Type and the applicable devices along with their Device Profiles you 

can click Next to enter the patient information. The final step is to start the recording and you do that by 

clicking Start Recording or clicking Standby within the Patient Information Wizard.  

Start Recording: 

You will then see your selected Workspace Layout appear with a status window showing the status of the 

recording which is starting. Finally, you will see the recorded signals appear in real time and you can start 

working with them. 

Standby Mode: 

The Standby Mode will open your selected workspace with a status window showing you have entered 

Standby Mode that gives you the option to connect to the Online Room for preparing, evaluating, and 

assisting the patient hook-up and finally start the recording using the Noxturnal App or Start Recording as is 

described in the step above. 
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When the user has connected the Noxturnal App to the online room the live traces that start to appear are 

NOT being saved to the recording. It is only a preview as is indicated by the preview status. The signal will start 

to record as soon as the user hits Start Recording either in the Noxturnal App or in the Noxturnal software. 

 

The user can also enter the standby mode any time after the recording has been started if he wants to pause 

the recording for some period of time by clicking the red rec button on top of the screen. 

 

By clicking the rec button, it will give you the option to either enter standby mode, stop the recording or cancel 

and continue with the recording. 

 

 

Performing Impedance Check and Bio Calibration 

For a closer inspection of the electroencephalography (EEG) electrodes an Impedance Check can be 

performed. After a recording has been started click the “Ohm” button.  
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The colors of the circles indicate the quality of the connections. Green is Good (<5 kΩ), yellow is Fair (5 kΩ to 20 

kΩ), and red is Bad (>20 kΩ).  

The next step is to perform the Bio Calibration. Go to the Scoring Button and select Bio Calibration. 

 

The selected task is highlighted, and the expected result listed on the bottom of the tab. When the event has 

been scored, the event will appear on the signal sheet.  
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Nox C1 Configuration 

The Nox C1 Access Point is equipped with 12 analog channels suitable for collecting of DC signals from auxiliary 

devices. The channels are collected on 6 ports, labeled DC IN from 1 to 12 on the top of the device; each 

analog port yields 2 channels. Auxiliary devices can be connected to the Nox C1 analog inputs. The voltage 

range allows interfacing signals from -5V to +5V. For further information on the Nox C1 Access Point, refer to 

the Nox C1 Manual.  

Nox C1 Access Point Network Configuration 

The default factory configuration of the Nox C1 Access Point is listed in the table below. The Nox C1 network 

configuration can be managed through Noxturnal. 

Nox C1 Network Configuration Details 

DHCP server DHCP pool: 192.168.101.64-192.168.101.127 

Static IP address 192.168.101.10 

Universal Plug and Play (UPnP) 

discovery 

Networking protocol that permits the Nox C1 to be 

discovered on a network  
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To manage the network configuration of the Nox C1 you can open an Online Room that has been configured 

(Devices > Online Rooms…) and select the Nox C1 within the room and click Edit Device. In the dialog below 

you can see how you can change the network configuration of the Nox C1.  

 

Upgrading Nox C1 Access Point firmware 

If a new version of the Nox C1 Access Point firmware is available for the connected device, Noxturnal will 

notify the user by displaying this message when the user starts an online recording. 
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The user can access the firmware upgrade by navigating to the Devices tab in the menu bar. 

Devices >> Online Rooms…  

 

Select the Nox C1 access Point and click Edit Device. 

 

In the device properties window select Upgrade Firmware. 
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The firmware upgrade will be indicated with a status bar and when finished will display like this. 

 

Activating Nox DC Channel License 

The DC channels on the Nox C1 Access Point are locked by default. To be able to use the DC channels on the 

Nox C1 you will need to have a Nox DC Channel license activated. For further information on this, please 

consult with Nox Medical or their sales representatives. 

The license is activated by clicking Set License in the Device Properties dialog that is shown below and 

following the instructions on the page. 
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Integration of Video Devices for Online Recordings  

Noxturnal supports online video recording. To use the digital video support provided by Noxturnal in an online 

recording you need to configure your system to include a video device. 

A video device can be added to your online system configuration and the setup saved for future use. To 

configure a video device with your system you must: 

1. Ensure that you have video codecs installed on your computer 

2. Ensure that the video device is connected to the same network as the Nox C1 Access Point and the 

computer running Noxturnal  

3. Setup an Online Room including the video device 

4. Setup a Recording Type including the video device and define the video profile  

5. Select the Online Room and start an online recording from the Noxturnal Recording page 

Setup an Online Room with a Video Device 

VIDEO CODECS 

Noxturnal’s support for video is governed by the video codecs that are installed on your computer system. 

These video codecs are specialized software that enables the compression and decompression of digital video. 

Noxturnal does not install any codecs but most computer systems have some types of codecs installed. You 

will require codecs to be installed on your computer system to use video with your Nox Sleep System. 

Noxturnal will then provide you with access to the features supported by these codecs. You can download the 

K-Lite Codec Pack from the Nox Medical support site:  

http://support.noxmedical.com/hc/en-us/articles/207882176  

VIDEO CAMERA INTEGRATION 

To setup an online recording including a video device follow the steps below. 
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1. Setup an Online Room in Noxturnal as explained in Online Room section (Devices > Online Rooms… 

from the Noxturnal toolbar).  

2. Add a video device to your Online Room by clicking Add Devices and select Video Device from the 

Device Types list.  

       

3. You will see the Device Properties dialog shown below. Check the applicable option, depending on the 

video device being used and click Next. 
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To setup your IP camera click Find… and Noxturnal will scan your network and discover video cameras that are 

connected to your network if they have UPnP (networking protocol that permits IP camera to be discovered on 

a network) enabled. Noxturnal offers default connection options for some IP cameras (Axis, D-Link cameras, 

Vivotek and Hikvision). Make sure that when choosing the connection string available in Noxturnal to choose 

the connection string (URL) per the recording you are performing, if only video is to be recorded, or both video 

and audio are to be recorded.  

If your camera is not automatically discovered by Noxturnal when using the Find… action you can always 

manually add your camera by entering the relevant connection string (URL) and the camera IP address into the 

File or URL field. 
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If you have a video device that is not supported by the default connection options mentioned above you can 

always manually add new connection strings (URL) to have them accessible in Noxturnal for future use. To do 

that browse to Tools > Settings > Advanced and select the Default Settings. Open the Video Profiles folder and 

open the IPCameras Excel sheet. You can add to the existing list of connection strings a new connection string 

for you video device and that will become available to use within Noxturnal.  

When you have entered the User and Password information for your camera you can click Start Preview to see 

if your camera is correctly set up and working with Noxturnal. If a delay is observed during the preview a delay 

input can be added to correct the video replay during the analysis. Click Next and you can give the camera a 

unique name and then click Finish.  
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You have now added the video device to your online room.  

Setup a Recording Type with a Video Device 

Noxturnal offers default Recording Types for online recordings that include video device. You can select one of 

the default Recording Types and start directly an online recording which includes a video device. You can also 

set up a custom Recording Type and define the Windows Media Profile to use with Noxturnal when recording 

and compressing the online video. To do that navigate to Devices > Recording Types… from the Noxturnal 

toolbar. In the Recording Types wizard select New and Online from the Recording Type dropdown list. 
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In the Online Recording Type wizard, you can add your video device as other devices. You can select the video 

profile to be used from the drop-down list, see image below.  
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Noxturnal offers selection of default video profiles, however, you can create custom profiles and access them 

for use in Noxturnal. For further information and instructions on how to do that refer to Nox Medical support 

site, Windows Media Profiles in Noxturnal. 

You have now configured your system to include a video device and you can start an online recording from the 

Noxturnal Recording page by double-clicking the room or click Configure Recording. 
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Working with recordings in Noxturnal  

Recording Results Page 

After downloading from a recording device or opening an existing recording in Noxturnal the Recording 

Results page is shown. This page contains an overview of the most common analysis parameters and the 

recorded signals. The result page is automatically updated when changes are made to the existing scoring or if 

the automatic analysis is run. When sleep stages are available, such as for recordings done with the Nox A1 

Recorders, you will see graphs and information with that information. For the Nox T3 Recorders, you will only 

see parameters available with those devices. 

 

Result Page Commands 

The Recording Results page has buttons for the following actions: 

• View Report: This option creates the default report for the recording, the report defined within the 

Recording Type (for further information refer to the Recording Types section). 

• Print Report: This option prints the default Report. 

• Recording Status: This option allows to set the status of recordings. Downloaded recordings always 

have the status New. If a recording has failed for any reason, the status can be set to Invalid. If the 

recording has been diagnosed, the status can be set to Scored. If the recording and the scoring have 

been reviewed, the status can be set to Reviewed. If the recording has been interpreted, the status 

can be set to Interpreted. If a recording has been diagnosed and accepted, the status can be set to 

Done. 

Patient Information 

The Information panel shows information about the recorded patient. Edit the recording properties and 
patient information by clicking the patient icon or by pressing the Ctrl+I shortcut key. 
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Sleep Parameters 

The Sleep Parameters panel shows a doughnut chart of different sleep stages if sleep stage events have been 
scored. 

 

 

• Total Sleep Time is the time the patient spent asleep (based on Hypnogram). 

• When Total Sleep Time is not available Est. Total Sleep Time (Same as AASM term Monitoring Time) 

is the parameter used. That is the time the patient is lying down during the recording. 

• Sleep Efficiency ranges from 0-100% where 0% means that the patient was awake the entire night 

and 100% means that he slept throughout the night. When sleep scoring is not available the software 

uses movement periods to estimate this parameter. 

Respiratory Indices 

The Respiratory Indices panel shows the main analysis parameters and their relation to severity. AHI, the 

Apnea Hypopnea Index, is the number of apneas and hypopneas per hour of sleep and Oxygen Desaturation 

Index (ODI) is the number of scored oxygen saturation drops per hour of sleep (default automatic analysis 

scores all desaturations of 3% or higher but this can be customized by the user. The severity goes from Normal 

→ Mild → Moderate → Severe and complies with the levels set forth by the AASM. If more than one night has 

been recorded, then these parameters will show the average values for all nights. Refer to the section Analysis 

Protocols for more information. 
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Overall Signal Quality and Single Body Source 

Overall Signal Quality is determined from the monitoring of signal quality of the following signals: oximeter, 
airflow, abdominal or thoracic respiratory effort signals. The lowest signal quality of those signals is displayed 
for the overall Signal Quality on the Recording Results Page and is represented from 0-100%.  

The Single Body Source result indicates whether the oximeter and RIP belt signals are originated from the 

same subject. For further information about this result, refer to the section Single Body Source. 

 

Signal Overview and Parameters 

The Signal Overview panel is a top down reviewing tool where recording results can efficiently be reviewed and 

edited. The overview panel is split up into analysis parameters on the right and signal overview on the left. 

 

The analysis parameters show a summary of the most common analysis parameters for a single night. If more 

than one night has been recorded, then each night is represented within its own panel. You can also select the 

period to view with the period menu located in the lower right corner of the application. Each parameter is 

color coded based on its severity ranging from green to red (Normal → Mild → Moderate → Severe). 

• Arousal Index is the number of arousals per hour during sleep time. 
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• Sleep Latency is the duration in minutes from Lights out (Analysis Start Time) until the first epoch of 

scored sleep. 

• REM Latency is the duration in minutes from the first occurrence of sleep until the first occurrence of 

REM. 

• Respiration is represented by indices. Indices are a method to represent analysis parameters in a 

standardized way. 

o Apnea Hypopnea Index (AHI) 

o Apnea Index (AI) 

o Hypopnea Index (HI) 

o Oxygen Desaturation Index (ODI) represents a number of oxygen desaturation events per 

hour of Total Sleep Time or alternatively Est. Total Sleep Time. 

o Snore Percentage is the proportion of sleep time spent in snore episodes (marked as Snore 

Trains) 

o Average dB is the average dB levels during snore train periods. 

• Signal Quality is determined from the monitoring of signal quality of the following signals: SpO2, 

airflow, abdominal or thoracic respiratory effort signals. The signal quality of those signals is and is 

represented from 0-100%. 

Signals and Events 

The signals and events plot in the signal overview panel give an overview of the whole night. 

• Signals in the overview can include: 

o Spectrogram for the channel displayed on the screen (Right click the Spectrogram to change 

the channel)  

o Sleep Stages/Hypnogram shows the sleep stages throughout the night 

o Arousals shows the arousals throughout the night  

o Movement 

o Position 

o Apneas/RIP Phase (phase between abdomen and thoracic respiratory effort signals) 

o Oxygen Desaturation (SpO2) 

o Pulse 

o Audio Volume (Snoring dB)  

o Leg Movements (optional) 

• Events shown in the overview include apneas and hypopneas, oxygen saturation drops, snoring 

episodes and artifacts. 
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Changing the Analysis Periods 

If a recording starts before all sensors have been attached or if the patient removes the sensors before the 

recording ends, it is possible to adjust the interval being analyzed by moving the Analysis Start  and Analysis 

Stop markers  to the appropriate location within the recording. All the analysis parameters are updated 

accordingly when these adjustments are made. 

 

To navigate into the recording use the synchronization marker . All signal sheets such as the PSG, 

Respiratory and Pulse Oximeter sheets are synchronized accordingly. If an interesting event is located in the 

overview, drag the synchronization marker over that area and browse into the relevant signal sheet to view 

the raw signals.  

Event periods can be added directly from the Signal Overview panel. To add an event period, locate the mouse 

pointer to the Periods panel and mouse click. The Event period menu will be available as shown below.  

 

Exclusion of invalid data can be performed in Signal Overview panel. To exclude invalid data from the 

recording locate the mouse pointer on of the signals, left mouse click and select an area by dragging left/right. 

Release the mouse button and the menu showed below will be available. The ‘Invalid Data’ events will be 

excluded from the report calculations. 
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Setting Units  

To change the unit system used to represent units such as height and weight navigate to Tools > Settings… 
from the Noxturnal toolbar. On the General property page locate the System Units drop-down list and select 
the applicable field to be edited. 
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Viewing Signals  

Workspace Menu Button 

The Workspace Menu Button        allows you to apply different Workspace Layouts and signal sheets to 

manage the way you want to see your recordings. The Workspace Layouts include a selection of signal sheets 

and signal sheet properties. Noxturnal offers a range of default Workspace Layouts and signal sheets. You can 

also setup custom Workspace Layouts and Signal Sheets. You can save all changes to your workspace layout 

for future use. This means that you can change settings on traces and setup your work environment as you see 

fit. 

 

You can use the Workspace Menu button to Add Sheet, create a New Workspace Layout, using a default 

layout to base it from or even Revert Layout after making changes. 

 

To save a customized signal sheet you right click on the signal sheet tab and select Save Sheet Layout As... 

When you have saved the customized signal sheet you can always Update Saved Layout if additional changes 

are made. For further information on signal sheets refer to the Signal Sheets section. 
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Signal Sheets 

A signal sheet shows one or more signals in a tab window in the workspace. Noxturnal comes with predefined 

signal sheets such as the Respiratory sheet, PSG sheet, and the Pulse Oximeter sheet. 

To add or remove signals in a signal sheet navigate the mouse to the Signals and Data task window located to 

the right of the workspace. When the mouse cursor is over this tab the Signals and Data task window will slide 

out. A list of all signals available is listed in this task window. A checkbox next to the signal determines if the 

signal is displayed in the sheet or not. Check/Uncheck the box to add or remove the signal from the sheet. See 

the Signals & Data tab here below. 
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Working with Signals 

 

The navigation bar allows to quickly navigate to any time in the recording. The blue line indicates where 

the user is located in the recording. Click on any location in the bar to jump to that time. 

Time axis displays the recording time and the time period in the window. Right-click on the time axis to 

change the interval in the window. Stretch/compress the time axis with the mouse to change time 

interval in the window. 

The synchronization marker located on the time axis is used to synchronize with other signal sheets and 

views. The clock on the right side of the navigation bar shows the time of the marker position. The 

synchronization marker can be dragged and moved in time. 

Signal value axis shows the name of the corresponding plotted signal and the value axis scale. The axis 

can be stretched/compressed with the mouse. To change the properties of the value axis, double-click on 

the axis and a dialog will appear where the properties can be changed. 

Signal plot in a pane. Signals can be adjusted in many ways. Resize the signal pane or move the signal 

pane around by using the mouse. To change the properties of the signal, double-click on the signal and a 

dialog will appear where the signal properties can be changed. To access all actions for an individual 

signal trace right click the signal trace and the following menu will be available. 
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Keyboard Navigation 

Navigate and manipulate the signal sheet by pressing the following shortcut keys: 
 
Navigation: 

• Right key = By default - Half page flip forward, user configurable 

• Left key = By default - Half page flip backward, user configurable 

• Ctrl + Right key = By default - Full page flip forward, user configurable 

• Ctrl + Left key = By default - Full page flip backward, user configurable 

• Page Down key = Page flip forward 

• Page Up key = Page flip backward 

• Home key = Start of recording 

• End key = End of recording 

• Shift + Right key = Increases time span in window 

• Shift + Left key = Decreases Time span in window 

• Shift + Ctrl + Left key = Jump to previous data session 

• Shift + Ctrl + Right key = Jump to next data session 

• - key = Zoom out of selection 

• + key = Zoom into selection 

• Mouse wheel = Scroll forward/backward 

• Mouse wheel + Ctrl key = Scroll up and down 

Active Signal: 

• Shift + Up = Increase signal scaling 

• Shift + Down = Decrease signal scaling 

• Ctrl + Up = Shift signal up 

• Ctrl + Down = Shift signal down 

• Shift + Return = Show active signal in new sheet 

• Shift + Delete = Remove active signal from sheet 

• Up key = Select signal above 

• Down key = Select signal below 

• Ctrl + F = Find events 

• F9 = Auto scale signal 

Signal Sheet: 

• Space = Play/Pause recording playback 

• Ctrl + W = Auto scale signals 

• Ctrl + A = Arrange signals 

Events: 

• Tab = Next event, if searching then next search result 

• Shift + Tab = Previous event, if searching then previous search result 

• Delete = Delete selected events, or delete events overlapping selection 

• Return = Deselect all events 
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• Esc = Clear all selections 

Working with Events  

Events are used to identify areas of interest in a signal. An event has a start and stop time and a type used to 

classify it. Events can either be manually added to a signal or scored by the automatic analysis to flag areas of 

interest. Events can be modified or removed. 

Scoring an Event 

To score an event go to a sheet containing signals; locate an area on a signal of interest. 

 With the left mouse button, highlight an area to score the event on. 

 Press the shortcut key for that event. Shortcut key can be assigned to an event type from Setting -> Event 

Types & Groups -> Edit -> Behavior. 

 

An alternative method for scoring an event is to highlight an area with the left mouse button, as before, but 

then right-click on the area and select an event from the list. 

Single Click Scoring 

Noxturnal offers the option to use Single Click Scoring. To activate the single click scoring action click the  I       

icon located in the Noxturnal toolbar.  

 

Within the applicable signal sheet manually score an event on the relevant signal trace, for instructions on how 

to manually score an event refer to the Scoring an Event section above. When you have scored the first event 
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the single click scoring feature will enable you to continue scoring the same event type with only single mouse 

click as you browse through the recording. 

Deleting an Event 

There are several ways to delete existing events: 

• Select an event by left-clicking it and then press the Delete key. 

• Right-click on an event and select Remove Event. 

• Select an area with the mouse that intersects with the events to delete and press the Delete key. 

Moving an Event 

To move an event to a different location, select the event by holding down the left mouse button and then 

drag the event to the desired location. Events can be dragged between signals as well as to a different time 

period. 

Resizing an Event 

To resize an event, move the mouse cursor over the left or right boundary of an event. The mouse cursor 

should change to an icon of an arrow pointing right and left. Once the icon has changed to an arrow, left-click 

and drag the event to the desired duration. 

Navigating Events 

There are several ways to navigate scored events in the recording: 

• Jump between the events that have been scored on a signal by clicking on the signal and pressing the 

Tab key which jumps to the next event in time. To jump to the previous event in time press the Shift 

+ Tab key. 

• In the top right corner of the workspace there is a search text box which allows you to search for any 

events that have been scored. Clicking on the textbox shows a dropdown list of all event types that 

have been scored. To search for events of some type click on the event type in the list. This shows 

the next event in time with that type. Click on the navigation buttons in the drop-down list to 

navigate the events. 

• Select View > Event Overview from the Noxturnal toolbar to bring up an overview window that 

shows all the events in a plot that have been scored in the recording. To navigate to a specific event, 

click on it in the overview plot. 
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Events overlapping Artifacts  

Events that are overlapping Artifacts are counted. However, events overlapping Invalid Data are not counted 

and are drawn faded. See figures below:  

 

 

Two Desats one with overlapping Artifact both drawn the same 

 

Two Desats, one is drawn faded as it will not be counted 
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Analysis Protocols 

An Analysis Protocol is a set of detectors that can be run on the recording to detect and mark various events 
within the recorded signals. The available analysis protocols, including the default protocols, are listed under 
the Analysis menu. To run an analysis protocol on the recording, select the applicable analysis from the 
Analysis menu and click on it. 

Noxturnal offers a range of default analysis protocols and you can also create a new analysis protocol which 

uses customized settings and/or detectors. To setup a customized analysis protocol go to Analysis > Manage 

Protocols from the Noxturnal toolbar. You can Edit and Rename an existing protocol or create a New based on 

an existing protocol.  

      

For this example, we will create a new analysis protocol. Select New in the Manage Analysis dialog. A new 

Analysis Protocol sheet will open up where the new protocol can be defined. A protocol is a collection of 

detectors and the function of a detector is to locate areas of interest within a signal and score the areas with 

events.   



Noxturnal Manual 

   

~ 63 ~ 

  
 

To add a detector to the protocol, choose detector from list of Detectors and select Add Detector >> General 

Properties and the Input Signal can be edited.   

When you have setup your analysis protocol click Save and Close and the protocol will be added to the list of 

available analysis.  

Working with Scorings  

A scoring is a collection of events that are scored on signals in the recording. The actions for working with 

scorings are located in the Scoring Button in the Noxturnal toolbar. The actions taken while working with 

scorings are listed in the sections below.  

  

If you have included an Analysis protocol in the Recording Type configured for the recording then when 

downloading from a Nox recording device, Noxturnal automatically uses the default analysis protocol to 

analyze the recording. For online studies you need to close down the recording when completed and when 

reopened from the recording library the defined default analysis will analyze the data. The automatic analyzing 

of the data creates a new scoring called Untitled Scoring, see screenshot above. In the Scoring Button you 

always see the Selected Scoring which is used for the reporting and recording overview features. You may 

easily create new scorings by using the features of the Scoring Button, for example if you make modifications 

to the automatic scoring, you can easily save that as a new scoring with the applicable name. 
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From the Scoring Button you can also Add Event Period or Add Note to the recording. 

New Scoring 

When using devices that record EEG, you can use the sleep staging features of Noxturnal. Noxturnal offers an 
automatic sleep stager with the system to assist the manual scorer.  Also, a manual sleep staging without using 
the automatic sleep stager first, is possible. 
To perform manual sleep staging click the Scoring Button and select a New Scoring.  
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After that, to start sleep staging you can select the Start Sleep Staging action from the menu in the Scoring 

Button. The number pad on your keyboard is used for the default sleep staging hotkeys. You can change the 

scoring hotkeys as explained below. 

Select a Scoring 

Multiple scorings can be associated with a single recording. All available scorings are listed in the scorings 

panel. Select the active scoring by clicking on it. 

Save Scoring 

Save the active scoring by clicking on the Save Scoring option. The user will be prompted for a name for the 

saved scoring. The saved scoring will be added to the list of scorings. 

Clear Scoring 

If a scoring is active, this action will clear it. If the active scoring has local modifications, the user will be 

prompted on whether he wants to save his local modifications. 

Delete Selected Scoring 

A saved scoring can be deleted by selecting it from the scoring list and clicking on the Delete Selected Scoring 

option. A prompt will come up, asking whether it is OK to delete the scoring. 

Scoring Keyboard Shortcuts 

A shortcut key is used to score events quickly. Shortcut key can be assigned to an event type from Setting -> 

Event Types & Groups -> Edit -> Behavior. 

As a general rule events should only have a single keyboard character as a shortcut, but a combination of Ctrl, 

Shift and Alt plus a keyboard character is supported. 

Noxturnal Reports  

 

 Note: Report results are fixed and are not updated when the analysis of the 

recording changes. 

 Note: If changes are made to the analysis another report can be generated or 

the existing report refreshed. 

Noxturnal offers a range of default reports that can be accessed by clicking the Reports menu from the 

Noxturnal toolbar.  

Generating Reports  

Report can be generated by clicking the View Report button on the Recording Results page or choose a report 

from the Reports menu in Noxturnal toolbar. 
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When you have generated a report in the report system, you can easily modify the report by using the Edit 

button which is visible in the toolbar when viewing reports. 

 

The Edit button launches the Edit Mode which allows you to edit the report in the same way as you would use 

Microsoft Word®. All changes that you make are immediately visible to you. You can also add new indices and 

even pre-defined report parts when interpreting a study. To stop Edit Mode, press the Edit button again. 

Changes that are made in the Edit mode are not saved as part of the report template. 

Customizing Reports 

Noxturnal offers a powerful custom report system that includes Microsoft Word® like editing capabilities. 

Reports in Noxturnal can easily be customized. To create a custom report template, follow the steps below. 

1. From the Noxturnal Toolbar select Reports -> Manage Reports… 

2. In the Manage Reports dialog select one of the options Edit, New or New Based On depending on 

your preferences. 

 
3. For this example, we will create a new custom report based on the default PSG Report. Select the PSG 

Report from the list of available reports and click New Based On. 

4. You will see the following dialog where you can give the new report template a name and then select 

Create. 
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5. A new sheet opens up with the default chosen report and in this window you can edit it. On the right 

side of the screen you can find a collection of Fields and Report Parts that you can use for your 

report. For further information on Report Parts and Fields refer to the Report Parts and Report Fields 

section below.  
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Note: In the report template you can hover over the fields (-) with the mouse to see the parameter’s details. 

See figure below. 

 

REPORT PARTS AND REPORT FIELDS 

Each report part represents a section of your report such as Oximetry Saturation, PLM Details etc. Report parts 

and fields can be created in Noxturnal and you can save report parts from default reports to have available 

when creating reports from scratch. 

CREATE A NEW REPORT PARTS 

You can create new report parts and save for later use. To do that select the applicable report part in the 

report template (or any custom created text/table) and drag and drop it to the list of Report Parts. Give the 
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report part a name and select the category. The new report part you created will be added to the list of Report 

Parts. 
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CREATE A NEW REPORT FIELD 

You can create new report fields and save for later use. To do that follow the steps below. 

1. For this example, we will select the default field available in Noxturnal Desat Drop ≥ 4% Count as a 

base for our custom field. Select the Desat Drop ≥ 4% Count and click New Based On. 

2. In the Edit Report Field dialog give the new field a name and edit the properties of the new field as 

required. 

  

For this example, we will change the desaturation drop to ≥ 3 and give the new field a descriptive name Desat 

Drop ≥ 3% Count. If the conditions are to be changed click Conditions to see all available conditions.  
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ADD REPORT PARTS AND FIELDS TO REPORTS 

To add Report Parts and Fields to your report set the mouse point to the preferred location in the report and 

double-click the desired report part from the list on the right side. Another way to add a Report Part and Field 

to a report is to drag and drop the desired report part/field into your report. 

REPORT HEADER AND FOOTER 

To customize the report header and footer follow the steps below. 

1. From the Noxturnal toolbar select Tools -> Settings -> User & Company and you will see the 

following wizard where you can enter user and company information.  

  

Fill in the fields shown above the applicable information. You can insert the information entered 

into your report using the corresponding Report Fields.  

 

2. To insert the information into the header/footer of your report place the mouse pointer within 

the upper part of the report, right click and select the option to Edit Header/Footer. 
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3. Add the applicable fields from the list of available fields into the header section. 

4. To add logo to your report header, click Format -> Insert Image… as shown below. 

      
 

5. To add a page numbering to your report, go the bottom of the report page right click and select 

Edit Footer. Right click within the footer area and select Insert > Page Number. 

When you have completed setting up your report template select Save. Your report will be added to the 

Report list available from the Noxturnal toolbar. 

Exporting Reports 

To export a report, click Export from the report toolbar. 

 

This will open a new dialog to specify the file format and the file name. Click the Save button when done and 

the report will be saved to the disk in the specified file format. 
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Printing Reports 

After a report has been generated the user can print the report. To print a report, select the Print option from 

the report toolbar. 

 

A dialog will open where the printing options can be changed. Click the Print button to print. 

The Recording Library  

The recording library shows and manages all the recordings that have been downloaded from the Nox 

recording devices and online studies. When recordings are opened or downloaded in Noxturnal they are 

automatically added to the recording library. It is also possible to acquire licenses to open EDF files, EDF+ files, 

Embla files and Somnostar files in Noxturnal, and the corresponding recordings will be added automatically to 

the recording library.  

To open a recording, select it from the recording library list and double-click. 

Archiving Recordings 

Recordings in the recording library can be archived to a different location or to a permanent storage. To 
archive a recording select one or more recordings in the library and click on the Archive Recording… button on 
the recording information panel. A dialog will appear guiding the user through the archiving process. 
 

Single Body Source 

The Single Body Source algorithm is a patent pending algorithm in Noxturnal that determines if the same 

subject wore the recording device and the associated sensors during the recording period. 

The algorithm can return one of three results. The results and their meanings are listed below. 

• Not analyzed: The algorithm has not been run for the recording. 

• Approved: A single body source can be verified for the recording. 

• Inconclusive: A single body source cannot be verified for the recording. 

A variety of factors can result in an Inconclusive result, including the following: 

• The recording does not contain the necessary signals (a pulse waveform signal from the oximeter and 

at least one RIP signal) 

• The necessary signals are noisy or include prominent artifacts 

• The sensors were not placed on the subject 

• The sensors were placed incorrectly on the patient or were displaced during sleep 

• The oximeter and the RIP belts were worn by separate subjects 

• The recording is too short (at least 15 minutes of concurrently recorded pulse waveform and RIP 

signals are necessary) 
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• The cardiac artifact in the RIP signals (caused by the emission of blood from the heart to the arteries 

and the resulting torso movement) is too small 

The Single Body Source algorithm can be run either as a tool (by clicking Tools -> Single Body Source) or as an 

analysis detector, which can be included in a custom analysis protocol. The tool runs automatically after 

recordings are downloaded from a recording device. 

The Single Body Source result is displayed on the Recording Results page under the Signal Overview section 

for each night and is also available as a report field for inclusion in custom reports. The result is indicated with 

one of the following symbols: 

 

Not analyzed 

 

A grey circle 

Approved 

 

A white check mark on a green 

circle 

Inconclusive 

 

A white question mark on a 

yellow circle 

The automatic calculation of the Single Body Source algorithm for downloaded recordings and display of the 

Single Body Source result can be turned on and off in Tools -> Settings… -> Advanced -> Single Body Source.  
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Compatible Devices 

The following table lists Ethernet supported devices and switches that have been validated with the Nox Sleep 

Assessment Systems. Noxturnal can receive, synchronize, display, and store signals from Ethernet supported 

devices when they are connected to the same network.  

SWITCHES, IP CAMERAS AND MICROPHONES 

Type Catalog Number 

Trendnet PoE Switch NA 

Axis T8351, microphone 3.5 mm NA 

Axis P3374, internet protocol camera NA 

AUXILIARY DEVICES SUPPORTED 

Type Catalog Number 

SenTec SDM NA 

Resmed TxLink NA 

Resmed AirsenseTM10 NA 

Resmed S9TM NA 

Resmed Aircurve NA 
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Regulatory Information 

Performance Testing and Validation Summary  

The Nox Sleep Assessment Systems have been tested and verified in various phases to include internal testing, 

verification, and validation as well as external testing to assure product safety, effectiveness, and reliability. 

The design was verified and validated, including clinical evaluation, throughout the design process, according 

to requirement specifications and intended use.  

Nox Medical holds an ISO 13485:2016 (MDSAP) certified Quality Management System which complies with the 

requirements of the Medical Device Directive (MDD - Council Directive 93/42/EEC as amended by Directive 

2007/47/EC); Canada – Medical Devices Regulations – Part 1 – SOR 98/282; Australia – Therapeutic Goods 

(Medical Devices) Regulations, 2002, Schedule 3 Part 1 (excluding Part 1.6) – Full Quality Assurance Procedure; 

Japan – MHLW MO No 169 (2004), as amended by MHLW MO No 60 (2021); PMD Act and USA – 21 CFR 820, 21 

CFR 803, 21 CFR 806, 21 CFR 807 – Subparts A to D. 

Description of Symbols and Abbreviations  

PG  Polygraphy 

PSG  Polysomnography 

 
 CE marking indicating conformance to the applicable 

EU regulations. 

(01)15694311110255(8012)VVvvr

r(11)YYMMDD(10)ZZZZZZ 

 Unique Device Identifier (UDI): the Application 
Identifier (01) indicates the device identifier (DI) (i.e. 
“15694311110255”), the Application Identifier (8012) 
indicates the software version (i.e. “VVvvrr”), the 
Application Identifier (11) indicates the production 
date/date of manufacture (i.e. “YYMMDD”, with “YY” 
the last two digits of the production year, “MM” the 
production month and “DD” the production day), and 
the Application Identifier (10) indicates the lot number 
(i.e. “ZZZZZZ”) 

 

 Unique Device Identifier (UDI) presented in data 
matrix format on Noxturnal CD 

 
 Manufacturer information 

 
 Date of manufacture 

 
 Batch code / Lot number 
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  Catalogue number / Reference number 
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     About 

This manual and associated translations are provided in electronic format according to Commission Regulation 

(EU) No 207/2012 of 9 March 2012 on electronic instructions for use of medical devices. They are also 

available in electronic format on Nox Medical’s website: www.noxmedical.com. 

Electronic versions are provided as PDF documents and a PDF reader is required to open the documents. PDF 

readers are commonly available at no cost for users. Refer to the applicable system and hardware 

requirements for the PDF reader that is used. 

Hard copies can be requested at no additional cost by emailing support@noxmedical.com. The hard copy will 
be sent within 7 calendar days. 
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Security Information 

The Noxturnal software complies with the following security standards and guidelines: 

• IEC 81001-5-1:2021 Health software and health IT systems safety, effectiveness and security – 

Security - Activities in the product life cycle 

• IEC 82304-1:2016 Health Software – General requirements for product safety 

• ANSI/AAMI SW96:2023 Standard for Medical Device Security – Security Risk Management for Device 

Manufacturers 

Cloud Setup: The Nox Cloud platform operating environment has the following certifications: 

• ISO 27001 

• SOC2 

• HITRUST 

Noxturnal Ecosystem 

STANDARD SETUP 

The standard setup contains local connections only to data files and peripherals. 

 

Data files are accessed directly (File I/O) while peripherals can be accessed using the following methods: 

• Serial  

• TCP/IP 

• Bluetooth 

CLOUD SETUP 

The cloud setup contains local connections to Local Settings and Peripherals but Recording data and 

Centralized Settings are stored on the Nox Cloud platform storage. 
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Local Settings are accessed directly (File I/O) while peripherals can be accessed using the following methods: 

• Serial  

• TCP/IP 

• Bluetooth 

DATA AT REST 

STANDARD SETUP 

The Noxturnal application stores data files containing the following settings: 

• Centralized Settings 

• Local Settings (overrides Centralized Settings when set) 

• Recording Data 

The software accesses the data files directly, and users can specify their location. It is recommended that local 

IT system policies are configured to allow access to the data files for relevant users only. 

It is recommended to encrypt the file systems used to store the data files. 

CLOUD SETUP 

The following data is stored on the Nox Cloud when connected to the cloud: 

• Centralized Settings 

• Recording Data 

Backups 

All data is backed up both fully and incrementally. Incremental backups are performed daily, weekly and 

monthly with full recovery at least annually. Backups are tested at regular intervals to ensure successful 

recovery of data. 

DATA IN TRANSIT (INTERNET / WAN) 

All Internet/WAN data is transferred using encrypted endpoints (on port 443). No non-encrypted endpoints 

are provided for data communication.  

The endpoint encryption uses TLS 1.2. The connection is encrypted using 256-bit encryption. SHA1 is used for 

message authentication and DHE_RSA as the key exchange mechanism. 

CLOUD BACKUPS 

All data is backed up both fully and incrementally. Incremental backups are performed daily, weekly and 

monthly with full recovery at least annually. Backups are tested at regular intervals to ensure successful 

recovery of data. 
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CLOUD SYSTEM MONITORING 

Best practices for system monitoring are employed to ensure the security and stability of the system. AWS 

Inspector, CloudWatch and CloudTrail are used to monitor the systems for vulnerabilities, unusual activities 

and performance issues. Wazuh is used to monitor the logs for unusual activities or unauthorized file system 

changes. All these systems can generate alerts and block potentially threatening IP addresses. 

CLOUD INTRUSION DETECTION AND PREVENTION 

To ensure that unauthorized people and services do not gain access to the platform, a number of intrusion 

detection and prevention measures have been implemented. 

Log files are monitored to detect and prevent brute force attacks. Log files are monitored to detect multiple 

failed attempts to try to access the system and then block the IP of the calling system when this occurs. 

CLOUD REPORTING 

In case of a security event is detected that has an impact on the security of the system or data, users are 

notified via Nox Medical’s Customer Relationship Process (SOP-0004)1. 

User Environment 

The following diagram explains the security ecosystem of the medical device from a user perspective: 

 

To ensure seamless operation of the Noxturnal software when using Cloud Mode, the following security 

measures shall be implemented by the user:  

• Whitelisting of *.noxhealth.com (the asterisk means that subdomains shall be included) in the user’s 
local firewall configuration 

• Allowing outgoing traffic on port 443 to *.noxhealth.com in the user’s local firewall configuration 

For seamless interoperability of Noxturnal and local peripherals the following security measures shall be 
implemented: 

• Whitelisting of USB peripherals if applicable 

 

1 Nox Medical operates and ISO 13485 Certified Quality Management System. 
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• Whitelisting of IP addresses of ethernet connected peripherals 

The application operates securely and effectively without requiring specific anti-malware software 

configurations. However, if anti-malware software is used, it is recommended to whitelist all data folders to 

ensure seamless operation of the Noxturnal software. 

SECURITY MEASURES 

It is strongly recommended to enable encryption and authentication on all peripherals that support such 

features. This applies to the following Nox Medical devices: 

• Nox C1 Access Point – supports pin code authentication 

• Nox A1 Recorder – supports pin code authentication 

• Nox A1s Recorder – supports pin code authentication 

• Noxturnal App – protect the mobile device running the Noxturnal App with built in mobile device 

security features. 

NOX C1 ACCESS POINT – SETTING THE PIN CODE 

The Pin Code can be set either via Noxturnal or the Noxturnal App. 

Noxturnal 

When C1 has been added to an Online Room in Noxturnal, the Pin Code can be set by navigating to Devices-

>Online Rooms->Edit Device (Select the relevant Nox C1 Access Point from the list of available Rooms): 

 

Hit the Set Password button: 
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And enter a password and confirm it: 

 

Noxturnal App 

Open the Noxturnal App in Online Mode. Open the Configuration for the relevant device: 
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When connection has been established, select the Configuration again from the top banner: 

 

Hit the Password field to set the password: 
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Enter the new password: 

 

The password has now been set. 

SECURITY UPDATES 
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All vulnerabilities notified / detected are assessed using the CVSS2. The score ranges between 0 and 10 and 

Security Updates are issued according to the following: 

• CVSS 9.0-10.0: Critical – turn off service until the vulnerability has been patched.  

• CVSS 7.0-8.9: High – Fix within 2 days.  

• CVSS 4.0-6.9: Medium – Fix within 1 week. 

• CVSS 0.1-3.9: Low – Fix within 4 weeks. 

• CVSS 0: None – No action. 

Security updates are delivered via distributors as soon as they are released. All installation packets are digitally 

signed by Nox Medical for ensuring security and integrity of the installer content. 

VULNERABILITIES 

No vulnerabilities have been identified that can affect cybersecurity or safety of the device. 

The vulnerability process used complies with the ANSI/AAMI SW96:2023 Standard for medical device security 

using methods described in the AAMI TIR57:2016 guidance – Principles for medical device security. 

SOFTWARE BILL OF MATERIALS (SBOM)  

The Software Bill of Material is provided as an IFU Addendum to this document. The SBOM may be maintained 

more regularly than the product under scope and it is therefore recommended to use the latest version when 

reviewing the content. 

Please reach out to support@noxmedical.com for full disclosure of the latest version of the Software Bill of 

Material for the product. The Software Bill of Material is updated with every product release / patch / 

Vulnerability detection and is available both in a human readable and a machine-readable format. 

EVENT LOGGING 

Noxturnal can be configured to log audit information to a SQLite database file on the local PC. Audit logging 

can only be enabled when running Noxturnal in Admin mode by navigating to Tools > Settings > Advanced. 

Once activated, an Export Audit Log button becomes available in the same section, allowing admin users to 

access and export the logged audit data. The logged information includes the following details: ID, date and 

time, username, recording ID, and user action. 

The following user actions are logged: 

• Recording opened 

• Saved scoring "scoring name" 

• Deleted scoring "scoring name" 

• Patient info changed 

 
2 The Common Vulnerability Scoring System (CVSS) is a method used to supply a qualitative measure of 

severity. 

mailto:support@noxmedical.com
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Appendix 

Default Derived Signals  

Noxturnal calculates default derived signals from the recorded source signals. Derived signals are statistical or 
direct transforms of any given signal and are described in the table below. 

Derived Signal Source Signal Description 

Activity Gravity X and 
Gravity Y 

Indication on patient activity/movements. The Activity signal 
is calculated from raw gravity signals (X and Y axis) measured 
by 3-dimensional accelerometer in the Nox recorders. The 
measured gravity signal is differentiated with respect to time 
and scaled by the correct scaling factor to create the derived 
activity signal. 

Audio Volume 
[dB] 

Audio Volume An Audio Volume signal in logarithmic scale (with units of 

decibels) is automatically calculated from the raw Audio 

Volume signal, which is in linear scale. The transform used to 

calculate the signal is V_dB = 20 log(x/P_0), where V_dB is 

the volume in decibels, P is the raw audio volume signal 

(which is a pressure signal with units of Pa) and P_0 is the 

reference sound pressure, which has a value of P_0 = 20 uPa 

in the Noxturnal software.  

Calibrated RIP 
Abdomen 

RIP Abdomen  The Calibrated RIP Abdomen Signal is calculated by scaling 
each value of the RIP Abdomen signal with the corresponding 
RIP K signal (derived signal). The flow signal will be 
automatically created if both: RIP Abdomen and RIP K signal 
exist. 

Calibrated RIP 
Flow 

RIP Thorax The calibrated RIP flow is calculated from a derivative of the 
sum of the RIP Thorax and calibrated RIP Abdomen signals 
(derived) and has the unit [V/s].  

Calibrated RIP 
Sum 

RIP Abdomen 
and RIP Thorax 

The Calibrated RIP Sum signal is calculated by adding the RIP 
Thorax signal with the RIP Abdomen signal after the latter 
has been scaled with the RIP K signal.  

Cannula Flow Cannula 
Pressure 

The Cannula Flow signal is a qualitative signal derived from 
the raw nasal Cannula Pressure signal and has the unit 
[cmH2O]. The nasal Cannula Pressure signal is low-pass 
filtered at 3 Hz and then the cannula flow signal is derived 
from a non-linear transformation.  

Cannula Snore Cannula 
Pressure 

The snoring signal (Cannula Snore) is derived by high-pass 
filtering a raw nasal Cannula Pressure or airflow signal.  

EMG Frontalis  E1-E3 and E2-E4 The EMG Frontalis-Left signal corresponds to the 
rereferenced signal E1-E3 and the EMG Frontalis-Right signal 
corresponds to the rereferenced signal E2-E4 
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Flow Limitation Cannula 
Pressure 

The Flow Limitation signal is derived by using a mathematical 
formula for calculating the flatness of an inhalation.  

Heart Rate ECG An R wave detection algorithm is run to detect each heart 
beat in the ECG signal. The instantaneous heart rate is the 
reciprocal of the intervals between successive heart beats. 
The heart rate signal has the unit [bpm] (beats per minute). 

Mask Pressure Raw Pressure The Mask Pressure signal is calculated on T3 and A1 devices, 
but in later versions of the devices the Mask Pressure signal 
is calculated in Noxturnal using the Raw Pressure signal, if the 
Mask Pressure channel is included in the device profile for 
the recording. The Mask Pressure should be identical to the 
Raw Pressure signal, but with a different signal type 

Nasal Pressure Raw Pressure The Nasal Pressure signal is calculated on T3 and A1 devices, 
but in later versions of the devices the Nasal Pressure signal 
is calculated in Noxturnal using the Raw Pressure signal, if the 
Mask Pressure channel is included in the device profile for 
the recording. The Raw Pressure signal is filtered with a high-
pass filter to create the Nasal Pressure signal. 

Position Gravity X and 
Gravity Y 

Indication of patient posture to discriminate between 
upright, supine, prone, left, and right position. The Position 
signal is created from Gravity X and Gravity Y and is the angle 
of the rotation of the body. It ranges from -180° to 180° and 
is 0° if the patient is facing directly upwards. 

PTT ECG and Pleth PTT, or pulse transit time, is defined as the time between an 
R wave in the ECG to a corresponding 50% rise in the pleth 
(photoplethysmography signal from the oximeter) signal 
from its nadir. 

Pulse Wave 
Amplitude 

Plethysmograph Pulse Waveform Amplitude (PWA) is a signal that shows the 
peak to peak value of a pulse waveform (the 
photoplethysmography signal from the oximeter) using a 
sample and hold method for the duration of the wave. The 
unit is [k]. 

RIP Sum RIP Abdomen 
and RIP Thorax 

The RIP Sum [V] is calculated as the sum of the RIP Abdomen 
and RIP Thorax signals. 

RIP Flow RIP Abdomen 
and RIP Thorax 

The belt flow is calculated from a derivative of the sum of the 
RIP Abdomen and RIP Thorax signals and has the unit [V/s]. 

RIP K RIP Abdomen 
and RIP Thorax 

To get a more accurate estimate of the actual respiratory 
flow from the RIP Abdomen and Thorax signals, the RIP 
Abdomen signal needs to be scaled using a calibration factor. 
This calibration factor is stored as the derived signal K. The K 
is found by seeking the optimal value giving the best 
correlation between the derived RIP flow and a reference 
pneumoflow. 
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RIP Phase RIP Abdomen 
and RIP Thorax 

The phase difference between the RIP Abdomen and RIP 
Thorax belts. The phase signal ranges from 0-180°. The RIP 
Phase is shown as a signal synchronized with RIP Abdomen 
and RIP Thorax belts. 

RIP Inductance 
and Fast RIP 
Inductance 

Raw RIP 
counters 

The RIP inductance signals are calculated on A1 devices, but 
in later versions of the devices the RIP inductance signals are 
calculated in Noxturnal using the Abdomen Raw and Thorax 
Raw signals. A transfer function is applied to the raw signals, 
which measure the resonant frequency of the RIP belts, to 
estimate the inductance of the belts. Two versions of each 
RIP inductance signal are available, one sampled at 25 Hz and 
the other at 200 Hz. 

RIP and Fast RIP Raw RIP 
counters 

The RIP signals are calculated on A1 and T3 devices, but in 
later versions of the devices the RIP signals are calculated in 
Noxturnal using the Abdomen Raw and Thorax Raw signals. 
The raw RIP signals are filtered with a high-pass filter to 
create the RIP signals. Two versions of each RIP signal are 
available, one sampled at 25 Hz and the other at 200 Hz. 

Reference EEG EEG Signals The reference EEG signal is an average of two or more EEG 
input signals.  

Respiratory 
Rate 

RIP Abdomen 
and RIP Thorax 

The respiratory rate signal is derived from the RIP Sum signal 
(derived signal). The respiratory rate is displayed as 
respirations per minute or [rpm]. 

Set Pressure Mask Pressure The Set Pressure signal is created from the Mask Pressure 
signal. It shows the most common Mask Pressure over a 5 
second interval. 

TcCO2 [Pa] TcCO2 The signal received from a transcutaneous CO2 device has 
the unit [torr]. The new TcCO2 signal which has the unit [Pa] 
is calculated, using the scaling factor 133.3 Pa/torr. 

Automatic Analysis Overview 

Clinical performance testing was conducted for the automatic analysis implemented in Noxturnal to 

demonstrate safety and effectiveness. The clinical performance testing consisted of retrospectively analyzing 

pre-existing clinical data from sleep studies that had already been collected and manually scored as part of 

routine clinical care. All scorers were qualified polysomnographic technologists and followed the American 

Academy of Sleep Medicine (AASM) scoring guidelines. The study protocol consisted of exporting the reported 

indices/events from the pre-existing manual scoring and then running the automatic analysis in Noxturnal on 

the same clinical data. The results of the automatic scoring were exported and compared to the results of the 

manually scored data.  The overall conclusion of the clinical performance testing is that the Noxturnal’s 

automatic analysis tools are found to be acceptable as a scoring aid in the clinical routine for the clinical 

purpose as specified for each analysis in the table below.  

 The automatic analysis was validated on clinical sleep recordings from an adult general population. 
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Name, Purpose, Indices, Events Clinical Condition Overview 

Bruxism Analysis  

The clinical purpose is to improve 
the efficiency of scoring EMG data 
that is consistent with potential 
bruxism-related events by 
labeling mandibular movements 
as measured by masseter EMG for 
review and confirmation by a 
trained healthcare professional.  

Limitations: The analysis is known 
to overestimate the number of 
bruxism events and on average 
42% of automatically scored 
events may have to be removed 
manually. The automatic analysis 
results should always be reviewed 
by a certified technician or a 
physician prior to diagnosis. 

Index scored: Bruxism Episode 

Index (BEI) - number of bruxism 

episodes per hour of sleep. 

Jaw contractions during sleep. 

Jaw contractions (possible 

bruxism-related events) are 

classified either as tonic 

(sustained clenching contractions) 

or phasic (repetitive brief 

contractions). 

The algorithm uses a masseter 
EMG signal and the activity signal. 
Periods of temporarily increased 
masseter muscle activity are 
found and scored as bursts. If the 
scored bursts fit the pattern of 
tonic or phasic bruxism episodes 
they are scored as such as defined 
by the AASM guidelines. By 
default, bruxism episodes are 
disregarded if they occur 
concurrently with patient 
movement, which is characterized 
by an increase in the activity 
signal. 

 

PLM Analysis 

The clinical purpose is to improve 
the efficiency of scoring periodic 
limb movement events.  

Limitations: The automatic 
analysis results should always be 
reviewed by a certified technician 
or a physician prior to diagnosis. 

Indices scored:  

Limb Movement Index (LMI) - 
number of limb movements per 
hour of sleep 

Periodic Limb Movement Index 
(PLMS) - number of periodic limb 
movements per hour of sleep 

Limb Movements during sleep: 
Periods, during sleep, lasting 0.5-
10 seconds where the muscle 
tone in a limb, typically measured 
on the tibialis muscle, is increased 
from baseline. 

Periodic Limb Movements during 

sleep: Period, during sleep, 

containing at least 4 limb 

movement events separated by 5-

90 seconds. 

The Limb Movement algorithm 
uses left leg and right leg EMG 
signals to identify periods where 
muscle tone is increased. 
Additionally, the activity signal is 
used to detect patient activity. 

The PLM analysis locates events 
of high muscular activity or kinetic 
activity and identifies as LM (limb 
movement) events. These are 
subsequently used to determine if 
any PLM (periodic limb 
movement) events are present. 
The analysis follows the 
guidelines set forth by the AASM. 

Respiratory Flow Analysis 
(calibrated RIP, Cannula)3  

1) The clinical purpose is to 
improve the efficiency of scoring 
Apneas, Hypopneas (using 
calibrated RIP, cannula) and 

Apneas during sleep: Periods 
lasting 10 seconds or longer 
where a patient stops breathing. 

Hypopneas during sleep: Periods 
lasting 10 seconds or longer 

1) The Apnea / Hypopnea (AHI) 
algorithm uses as applicable the 
respiratory cannula flow or 
respiratory calibrated RIP flow 
signal depending on the analysis 
run and can utilize scored events 

 
3 Includes AHI and ODI Algorithm and Apnea Classification Algorithm 
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desaturation events from 
oximeter.  

Limitations: The results should 
always be reviewed by a certified 
technician or a physician prior to 
diagnosis. 

Indices scored: 

Apnea Hypopnea Index (AHI) - 
number of apneas and hypopneas 
per hour of sleep 

Apnea Index (AI) - number of 
apneas per hour of sleep 

Hypopnea Index (HI) - number of 
hypopneas per hour of sleep 

Oxygen Desaturation Index (ODI) - 
number of oxygen desaturation 
events per hour of sleep. 

2) The clinical purpose is to 
improve the efficiency of 
classifying apneas into central 
apneas, mixed apneas or neither.  

Limitations: The results should 
always be reviewed by a certified 
technician or a physician prior to 
diagnosis. 

Indices scored: 

Central Apnea Index (CAI) number 
of central apneas and hypopneas 
per hour of sleep 

Mixed Apnea Index (MAI) - 
number of mixed apneas per hour 
of sleep 

Central Mixed Apnea Index 
(CMAI) - number of central and 
mixed apneas per hour of sleep 

where a patient’s breathing is 
severely reduced. 

Oxygen desaturation during 
sleep: Periods where the oxygen 
saturation of a patient's arterial 
blood falls below the baseline by 
3% or more. 

Central Apneas during sleep: 
Periods lasting 10 seconds or 
longer where a patient stops 
breathing and respiratory effort is 
absent. 

Mixed Apneas during sleep: 
Periods lasting 10 seconds or 
longer where a patient stops 
breathing. Respiratory effort is 
absent at the start of the period 
but present at the end. 

 

in the EEG to score hypopneas. 
The scored EEG events are 
arousals during sleep scored 
manually. The algorithm also uses 
an SpO2 signal measured by an 
oximeter to find desaturation 
events which are used to score 
hypopneas, but the algorithm 
does not score the desaturation 
events.  

The AHI algorithm determines if a 
patient is breathing normally, if 
breathing is severely reduced 
resulting in a hypopnea, or if a 
patient is not breathing resulting 
in an apnea. If breathing is 
severely reduced the algorithm 
looks if there is an arousal or a 
drop-in blood oxygen saturation 
associated with the reduction in 
breathing to score an hypopnea. 

The Desaturation (ODI) algorithm 
uses an SpO2 signal measured by 
an oximeter to determine if there 
is a drop of 3% or more in blood 
oxygen saturation. 

The analyses follows the 
guidelines set forth by the AASM. 

2) The Apnea Classification 
algorithm uses a respiratory flow 
signal, with the addition of the 
abdomen and thoracic respiratory 
Inductance plethysmography 
(RIP) signals. 

The Apnea Classification 
algorithm classifies scored apneas 
as central or mixed if respiratory 
effort is absent during the apnea, 
or neither. 

The analysis follows the 
guidelines set forth by the AASM. 

Sleep Staging Analysis 

The clinical purpose is to improve 
the efficiency of scoring sleep 
stages with the intent of 
estimating total sleep time.   

Limitations: The automatic 
analysis results should always be 

The pattern of sleep stages is 

used to analyze how the 

individual sleeps and determine 

any abnormalities in the sleep 

profile that might indicate sleep 

disorders. 

The algorithm uses 
electroencephalography (EEG) 
signals, electrooculogram (EOG) 
signals, activity signal and 
submental electromyography 
(EMG) signal to provide pre-
scoring of sleep stages according 
to the AASM manual.  
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reviewed by a certified technician 
or a physician prior to diagnosis. 

The following events are scored: 
Sleep stage W (Wake), Stage N1, 
Stage N2, Stage N3 and Stage R 
(REM) 

 

The algorithm is implemented 
with an artificial neural network. 
Various features are calculated 
from the EEG, the EOG, the 
activity signal and the submental 
EMG and fed into the neural 
network, which returns sleep 
stages for 30 second epochs, to 
simulate the way sleep stages are 
scored by human scorers. 

Arousal Analysis 

The Clinical Purpose is to improve 
the efficiency of arousal scoring 
with the intent of improving the 
scoring of hypopneas. 

Limitations: The automatic 
analysis results should always be 
reviewed by a certified technician 
or a physician prior to diagnosis. 

The following events are scored: 
Arousals detected in the EEG 
signals. 

Arousals in sleep: 

Abrupt shift of EEG frequency 

that lasts 3 – 10 seconds after 10 

seconds of stable sleep. Resulting 

arousal index is used to detect 

any abnormalities in the sleep 

profile that might indicate sleep 

disorders. Arousals are 

considered when detecting 

hypopneas and thus are related 

to the Apnea Hypopnea Index 

(AHI). 

The algorithm uses 
electroencephalography (EEG) 
signals, electrooculogram (EOG) 
signals to provide pre-scoring of 
arousals according to the AASM 
manual.  

The algorithm is implemented 
with an artificial neural network. 
The recorded raw EEG, EOG, and 
EMG signals are inputted into the 
artificial neural network, which 
returns events where the arousals 
occur to simulate the way 
arousals are scored by humans. 

Nox BodySleep Analysis 

The Clinical Purpose is to get 
more accurate estimate of sleep 
time during a home sleep study 
by correctly classifying wake in a 
home sleep study. 

Limitations: The automatic 
analysis results should always be 
reviewed by a certified technician 
or a physician prior to diagnosis. 

The following events are scored: 
Sleep state Wake, Sleep state 
NREM and Sleep state REM 

Sleep time is used as a metric 

when calculating AHI (Apnea-

Hypopnea index) during sleep and 

can also be used to evaluated 

duration of sleep to determine 

any abnormalities in the sleep 

profile that might indicate sleep 

disorders. 

The “Nox BodySleep” is an 
Artificial Intelligence (AI) method 
intended to classify 30-second 
epochs into the states of REM 
sleep, NREM sleep and Wake. It 
uses respiratory inductance 
plethysmography (RIP) signals and 
actigraphy to measure the impact 
of brain state change on the body 
and estimates sleep states from 
those signals. 

SAS Sleep Staging Analysis 

The Clinical Purpose is to improve 
the efficiency of scoring sleep 
stages with the intent of 
estimating total sleep time. 

Limitations: The automatic 
analysis results should always be 
reviewed by a certified technician 
or a physician prior to diagnosis. 

The following events are scored: 
Sleep stage W (Wake), Stage N1, 

The pattern of sleep stages is 

used to analyze how the 

individual sleeps and determine 

any abnormalities in the sleep 

profile that might indicate sleep 

disorders.  

 

The algorithm uses 
electroencephalography (EEG) 
signals, electrooculogram (EOG) 
signals, and frontalis 
electromyography (EMG) signals 
to provide pre-scoring of sleep 
stages according to the AASM 
manual. 

The algorithm is implemented 
with an artificial neural network. 
The recorded raw EEG and EOG 
signals are inputted into the 
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Stage N2, Stage N3 and Stage R 
(REM) 

artificial neural network, which 
returns sleep stages for 30 second 
epochs, to simulate the way sleep 
stages are scored by human 
scorers. 

SAS Arousal Analysis 

The Clinical Purpose is to improve 
the efficiency of arousal scoring 
with the intent of improving the 
scoring of hypopneas. 

Limitations: The automatic 
analysis results should always be 
reviewed by a certified technician 
or a physician prior to diagnosis. 

The following events are scored: 
Arousals detected in the EEG 
signals. 

Arousals in sleep: 

Abrupt shift of EEG frequency 
that lasts 3 – 10 seconds after 10 
seconds of stable sleep. Resulting 
arousal index is used to detect 
any abnormalities in the sleep 
profile that might indicate sleep 
disorders. Arousals are 
considered when detecting 
hypopneas and thus are related 
to the Apnea Hypopnea Index 
(AHI). 

 

The algorithm uses 
electroencephalography (EEG) 
signals, electrooculogram (EOG) 
signals, and frontalis 
electromyography (EMG) signal to 
provide pre-scoring of arousals 
according to the AASM manual. 

The algorithm is implemented 
with an artificial neural network. 
The recorded raw EEG, EOG, and 
EMG signals are inputted into the 
artificial neural network, which 
returns events where the arousals 
occur to simulate the way 
arousals are scored by humans. 

 

 


